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Design Plan

Rationale

In 2016, the University of California (UC), Berkeley was investigated by the Department of
Justice and found to be in violation of the Americans with Disabilities Act (ADA) when material
on their public website was deemed inaccessible by individuals who were deaf or hard-of-
hearing.! Unfortunately it took multiple individuals, unable to access and utilize these materials,
filing a complaint for this prominent ADA violation to come to light. Due to the extremity of the
circumstances, UC Berkeley made the decision to remove many publications and videos from
public use as a remedial measure rather than correct the existing materials.?

While providing accessible resources in accordance with the Americans with Disabilities Act has
been a mission at the University of Maryland, College Park for some time, there has only
recently been a push to ensure that departments are doing their due diligence to produce
accessible materials online. Corrective actions are necessary in order to prevent a situation
similar to that of UC Berkeley from arising.

I ' ust comply with federal regulations in relation

to its grants. In addition to meeting the requirements of the Americans with Disabilities Act,
Section 508 law requires that all electronic and information technology be accessible by those
with disabilities, or provided with an alternative means of receiving the information unless
situations of “undue burden” on the department or agency come into play.2 Training the
organization’s staff and faculty on how to do so will better prepare documents for a final
compliance check and ensure that [Jjjjjijis not breaking any laws.

I (e Creating Section 508 Compliant PowerPoint, Word and

PDF Documents training will provide an introduction to accessibility and Section 508
compliance, as well as provide guidance on how to prepare compliant electronic documents.
This training will be unique in that most Section 508 and accessibility trainings exist as online
training videos or as informational handouts, while this training will take place in-person and
allow the participants the opportunity to apply what they learn in real-time.

To ensure mastery of the course objectives, participants will be actively engaged by preparing
their own compliant PowerPoint, Word and PDF documents. Should a participant fail to
produce compliant materials, facilitators will be available for remediation. Attendees will be

L Civil Rights Division, U.S. Department of Justice. (2016). Letter of Findings [U.S. and electronic mail document].
https://news.berkeley.edu/wp-content/uploads/2016/09/2016-08-30-UC-Berkeley-LOF.pdf

2 Public Affairs, UC Berkeley. (2017). Letter from Cathy Koshland, UC Berkeley vice chancellor for undergraduate
education [announcement]. http://news.berkeley.edu/2017/03/01/course-capture/

3 Rehabilitation Act of 1973 (amended). 29 U.S.C. §794 (d) https://www.gpo.gov/fdsys/pkg/USCODE-2011-
title29/html/USCODE-2011-title29-chap16-subchapV-sec794d.htm




provided with a certificate of completion after successful completion of the final Level 2
evaluation that concludes Module 4.

The in-person training will be implemented over the course of one day. There are four total
modules in this training including: ‘An introduction to Section 508 compliance’; ‘How to Make
PowerPoints Accessible’; ‘How to Make Word Documents Accessible’; and, ‘How to Make PDF
Documents Accessible’. The first module will be approximately 45 minutes long, with the
remaining three modules lasting approximately one hour and 30 minutes each. An additional 1
hour 45 minutes will also be built in for house-keeping, breaks and lunch. The anticipated class
size for each iteration is 20 or fewer learners in order to accommodate the technological needs
of the training space. Multiple iterations will be offered to accommodate all staff and faculty
within the organization. After all staff and faculty are initially trained, this training will be
offered once quarterly for new hires or as demanded.

The training will be conducted in a room that has Wi-Fi internet access, a computer and a
projector setup to display training materials and visual aids. A PowerPoint slide presentation,
individual activities and group discussion will be used to facilitate the training. Participants will
be required to bring their || I '2rtop to the training, with updated versions of the
Microsoft Office Suite and Adobe Acrobat installed. The facilitator will provide sample
PowerPoint, Word and PDF documents electronically to the participants for individual activities
and the final evaluations. Thumb drives containing these materials will also be made available
as backup. A train-the-trainer session will be required for all facilitators before they will be
approved to implement the course.

Target Population

The population for this course includes current employees, both faculty and staff ]
Y oy
employees may also participate given written permission of their supervisor. Currently JJj
I < approximately 50 full-time employees and 30 hourly employees. It will be
strongly encouraged for all faculty and staff to attend this training during initial iterations, with
any new employees attending quarterly iterations thereafter.

Participants will have a minimum of a Bachelor’s degree, as all full-time employees ||} N
hold at least that level of education. |l 2rrroximately 25% of full-time employees hold a
PhD, and 75% hold at least one Master’s degree. The majority of employees speak English as
their first language and as such are expected to have at least high-school level reading and
writing skills in English, though likely higher due to their work in academia.

Il catesorizes itself as being a multi-disciplinary organization, as the educational
background of employees does vary dependent on current grant awards and necessary
expertise to execute those projects. The age of employees i is not made public,
however when taking education into account it is estimated that employees are at least over
the age of 21 (many individuals in the United States graduate with a Bachelor’s degree at the
age of 21-22). It is expected that the participants will have the basic technical experience



required to be able to complete the tasking of this course as all employees are required to use a
computer in their day-to-day tasking. Participants will have at least beginner level skills in
Microsoft PowerPoint, Word and Adobe Acrobat. Participants are not expected to have
advanced computer skills.

It is not expected that those participating will be self-motivated to attend. Many researchers|jj
Il are consumed by their demanding research projects and are likely to view this training as
extra work. Additionally, they are likely to view Section 508 compliance as tasking for the
project managers, or the person that does a final quality check before providing final
deliverables. That being said, some participants may have a personal experience that motivates
them to attend, or will have an understanding of the importance of providing materials that are
accessible by those that may have disabilities or impairments which in turn motivates them to
attend. Participants may also feel more motivated to attend if they have the understanding that
meeting Section 508 compliance is a requirement of the federal grants they are working on.

Very few participants will come to this training with experience in making electronic documents
accessible, and it is expected that this training will be completely out of the participants’
wheelhouse. Explanations on why things are required to be done a certain way will be
important to this population, as the population is expected to be very intellectual and respond
well to empirical evidence. The facilitators will need to be sure to provide thoughtful and
thorough explanations to participants. It is not expected that this training will make participants
experts in Section 508 compliance, however it will provide a crash-course in making electronic
documents accessible which will better prepare deliverables for a final compliance check.

Learning Objectives

Module 1: An Introduction to Section 508 Compliance
*not developed during EDUC 602*

Module 2: How to Make PowerPoints Accessible
*not developed during EDUC 602*

Module 3: How to Make Word Documents Accessible
*not developed during EDUC 602*

Module 4: How to Make PDF Documents Accessible

Terminal Learning Objective

Given in-class instruction, a slide presentation, class discussions, a personal computer with
Adobe Acrobat installed, and an electronic PDF file a Creating Section 508 Compliant
PowerPoint, Word and PDF Documents participant should be able to produce an accessible PDF
document without error in three or fewer attempts.




Enabling Learning Objectives

1.

10.

Given instructor demonstration, in-class discussion, a personal computer with Adobe
Acrobat installed, and a Word document practice file, the Creating Section 508
Compliant PowerPoint, Word and PDF Documents participant should be able to convert
a Word document file to PDF format (best for electronic distribution) without error.
Given instructor demonstration, in-class discussion, a personal computer with Adobe
Acrobat installed, and a PDF practice file, the Creating Section 508 Compliant
PowerPoint, Word and PDF Documents participant should be able to locate and employ
a “full check” using the ‘Accessibility’ tool without error.

Given instructor demonstration, in-class discussion, a personal computer with Adobe
Acrobat installed, and a PDF practice file, the Creating Section 508 Compliant
PowerPoint, Word and PDF Documents participant should be able to locate and employ
the “Explain” function within the ‘Accessibility Checker’” without error.

Given instructor demonstration, in-class discussion, a personal computer with Adobe
Acrobat installed, and a PDF practice file, the Creating Section 508 Compliant
PowerPoint, Word and PDF Documents participant should be able to input the
document title and author without error.

Given instructor demonstration, in-class discussion, a personal computer with Adobe
Acrobat installed, internet access, and a PDF practice file, the Creating Section 508
Compliant PowerPoint, Word and PDF Documents participant should be able to identify
color contrast issues without error.

Given instructor demonstration, in-class discussion, a personal computer with Adobe
Acrobat installed, and a PDF practice file, the Creating Section 508 Compliant
PowerPoint, Word and PDF Documents participant should be able to designate the
primary language of the document without error.

Given instructor demonstration, in-class discussion, a personal computer with Adobe
Acrobat installed, and a PDF practice file, the Creating Section 508 Compliant
PowerPoint, Word and PDF Documents participant should be able to remove
unidentified objects in the reading order of the document until completed without
error.

Given instructor demonstration, in-class discussion, a personal computer with Adobe
Acrobat installed, and a PDF practice file, the Creating Section 508 Compliant
PowerPoint, Word and PDF Documents participant should be able to rearrange the
reading order of the document until completed without error.

Given instructor demonstration, in-class discussion, a personal computer with Adobe
Acrobat installed, and a PDF practice file, the Creating Section 508 Compliant
PowerPoint, Word and PDF Documents participant should be able to compose missing
alternative text on images and figures until completed without error.

Given instructor demonstration, in-class discussion, a personal computer with Adobe
Acrobat installed, and a PDF practice file, the Creating Section 508 Compliant
PowerPoint, Word and PDF Documents participant should be able to assign header
designations to a table until completed without error.



Course Description

The Creating Section 508 Compliant PowerPoint, Word and PDF Documents training is designed
to provide an introduction to accessibility and Section 508 compliance, as well as provide
guidance on how to prepare compliant electronic documents. The training will focus on
PowerPoint, Word and PDF documents, with the understanding that there are other electronic
and informational technology file types that are included under Section 508 law that will not be

covered in this course. This one day in-person training course | NG
N i b

provided to all full-time faculty and staff within the organization. Hourly employees may also
attend this training given written permission of their supervisor.

The goal of this training is to provide an introduction to making electronic documents accessible
which will better prepare deliverables for a final Section 508 compliance check. After
completion of the course, participants should be able to produce accessible PowerPoint, Word
and PDF documents.

The training will consist of 5 hours and 15 minutes instructional seat time and include the
following modules:

e Module 1: An Introduction to Section 508 Compliance (45 minutes)

e Module 2: How to Make PowerPoints Accessible (1.5 hours)

e Module 3: How to Make Word Documents Accessible (1.5 hours)

e Module 4: How to Make PDF Documents Accessible (1.5 hours)

The training will also include an additional 15 minutes of housekeeping at the beginning of the
training, a 10-minute break between each module (30 minutes in total), and a one hour lunch.

Instructional methods will include in-class instruction and demonstrations, PowerPoint slide
presentation, class discussions and individual activities. For each training there will be one lead
facilitator and one co-facilitator. The co-facilitator will largely be responsible for assisting in
feedback during individual activities and recording observations throughout the course.
Facilitators will be provided with a facilitators guide, PowerPoint slide presentation, electronic
versions of practice activities, a USB flash drive (used to provide participants with electronic
documents should there be internet connectivity issues), evaluation files in electronic form and
reaction surveys.

Class size will be limited to 20 students per iteration, with multiple iterations being offered in
order to accommodate current faculty and staff (estimated three initial iterations), and
additional iterations provided quarterly to any new faculty and staff (estimated one per
guarter). The training room must accommodate 20 personal computer set-ups, with power
supply and Wi-Fi internet access, as well as accommodate computer projection for the
facilitator. Tables should be arranged to allow small group discussion, while still allowing every
participant to see the projection screen. Each participant will be required to bring their |}



- laptop, and should be sure to run any updates for the Microsoft Office Suite and Adobe
Acrobat prior to the training.

This training will be evaluated using Kirkpatrick’s Levels of Evaluation: level one (reaction), level
two (learning) and level three (behavior). Throughout the duration of the individual activities in
Modules 2, 3 and 4, facilitators will be responsible for working closely with participants to
provide feedback on their individual activities. Participants will be required to complete a final
evaluation at the end of each module, where they will apply what they have learned to prepare
a PowerPoint, Word and PDF document for compliance. Participants will also be asked to
complete a brief level one reaction survey after completion of their final evaluation.

Evaluation Strategy

During implementation of this course, participants will be evaluated using the first three levels
of Kirkpatrick’s Levels of Evaluation — level one reaction, level two learning and level three
behavior.

A level one evaluation will be distributed by the facilitator after the completion of the course,
following the Module 4 closure section. The level one evaluation will be provided in the form of
a short reaction survey and ask for the participants reaction to the course and facilitators. The
reaction survey will be approximately six questions, and consist of a combination of Likert and
open-ended questions. Specifically, participants will be asked to provide feedback related to
overall usefulness of the information provided throughout the course, whether they believe the
information provided allowed them to meet the learning objectives, facilitator effectiveness,
and what they liked/disliked about the course and areas for improvement. These reaction
surveys will be anonymous. Additional level one evaluation results will be compiled by the co-
facilitator, who will be recording observations throughout the duration of all class-discussions.
Level one evaluation results will be compiled and reviewed by the training team to determine if
immediate actions/revisions are necessary.

Level two evaluation will take place at multiple intervals throughout the course. Evaluation will
be both informal and formal. First, participants will be evaluated by facilitator observation
during class discussion in Module 1. During Modules 2 through 4, participants will be evaluated
by facilitator observation during group and individual activities. Participants will be provided
with a practice file for each module and will work individually to make these files compliant.
Discussion amongst small groups is encouraged during group activities, with larger group
discussion as necessary. However, each participant will be expected to complete their own files
for each activity. Facilitators will be present and walking around the room throughout activities
to assist with any questions and provide feedback.

The course will conclude each module with a formal evaluation, where participants will be
asked to produce compliant documents based on the module topic (PowerPoint, Word and
PDF). Participants will be provided appropriate files in which they will need to apply what they
have learned throughout the course. Participants will have approximately 30 minutes to
complete the each evaluation. Participants will be provided with feedback and recommended



areas for remediation if necessary. After successful completion of the course, the participant
will receive a certificate of completion.

A level three evaluation will also be implemented in order to determine whether the training
content has translated into a change in behavior. The level three evaluation will be conducted
in two ways. First, an evaluation survey will be emailed by the training team to participants
using the Qualtrics survey platform 90 days after completion of the course. The evaluation will
ask learners whether or not they have had the opportunity to apply what they learned to
deliverables they have produced since the training. As a second layer of evaluation, the training
team will reach out to project managers and the Director of Research in order to determine if
there has been an improvement to the state of deliverables (in terms of Section 508
compliance) turned into them within this time period. This evaluation will take place informally
over email and be a singular open-ended question. Level three evaluation results will be
compiled and reviewed by the training team.

Participant Prerequisites
Participants of this training course must be a full-time faculty or staff employee |||} QI EEEE
. Participants should
be written into a current federal grant, however state-funded employees will also be permitted
to attend this training. Hourly employees will be permitted to attend this training with written
permission granted from their supervisor. Registration priority will be given to full-time
employees, with any open seats at the time that registration closes being offered to hourly
employees that have received the appropriate approval of their supervisor prior to registration.

Participants should have an interest in improving accessibility in deliverables. It is not required
that participants have experience with making electronic documents accessible. In fact, it is not
expected that participants will have any previous experience with doing so.

Participants must have English reading and writing skills at a high-school level, as the course will
only be taught in English at this time. While many participants are expected to have advanced
degrees, only a minimum of a Bachelor’s degree, in any discipline, is required to take this
course.

Participants will be required to bring their || Bl '2rtop with the most recent updates to
Microsoft Office Suite and Adobe Acrobat installed. Spare computers will not be made available
during the training. Basic computer skills are necessary for this course, as this course will not
cover basic computer functions. There will not be an IT team member present for this training.
It is requested that participants troubleshoot any existing technological problems they have
with their computer prior to attending the training. Participants should have proficiency in
using Microsoft PowerPoint, Microsoft Word and Adobe Acrobat. They should also produce or
work with these file formats (.docx, .pptx and .pdf) as part of their daily job tasking.



Participants must be willing to participate in group discussion and engage with the facilitator. It
is also important that participants agree to complete all evaluations within the time designated,
including post-training evaluations.

There is no prerequisite coursework for this training.

Participants will be required to register for the training at least two-weeks prior to the training
date. A waitlist will be kept for any attendees exceeding the cap of 20 participants. Any
individuals on the waitlist will be given priority during the next iteration of the training.
Participants must attend the entire full-day training event. If a participant needs to cancel their
registration, it is requested that they do so within 48 hours of the training event to ensure their
seat can be given to someone on the waitlist. Full name, title, division and email address will be
required from all participants.

The training will be offered at ||| || | I 2 therefore participants are required to
work on-site |Jillor be able to travel to the site of the training.

If a participant is in need of special accommodations, it is requested that they contact the

training team at || 2t 'cast one week prior to the training. This is to

ensure that all necessary accommodations can be met.

Facilitator Prerequisites
The facilitator and co-facilitator of the Creating Section 508 Compliant PowerPoint, Word and
PDF Documents training must be a current full-time faculty or staff employee at ||| | |} | ) I NIE

. Facilitators should
have a minimum of a Bachelor’s degree and have English reading and writing skills of at least a
college level.

Facilitators must have prior experience with creating Section 508 compliant electronic
documents. It is not required that facilitators have prior experience with submitting electronic
documents through a federal Section 508 compliance testing process, though it is encouraged.
This prior experience will better prepare the facilitators to answer questions that may arise.

The facilitators must have intermediate computer skills, as well as advanced skills in Microsoft
PowerPoint, Word and Adobe Acrobat. Facilitators should be comfortable with troubleshooting
technical issues related to Section 508 compliance. Dependent on the computer operating
system and versions of software, practice files may have different accessibility results. A
facilitator must be able to interpret and provide explanations on scenarios that may not be
anticipated in the facilitators guide. Facilitators are not expected to provide support for
technical issues that are not related to preparing an accessible document.

As this course will present new skills to participants, there is the possibility that participants will
get frustrated if they run into an unanticipated issue. The facilitators will need to know how to
troubleshoot these issues in order to keep the training on track and mitigate frustration.



Facilitators must also be able to manage class time and discussions. They must be able to
supplement class discussions should responses from participants be minimal or off-the-mark.

The co-facilitator will be required to take detailed observation notes throughout the course
while still assisting with the training, and therefore must be able to multi-task.

Facilitators will be required to complete a train-the-trainer course prior to implementing the
course. The train-the-trainer course will be led by a member of the training team and will go
over all course materials. It will require the facilitator to simulate a brief demo session for the
training team to ensure that they can adequately lead a training. The train-the-trainer session
will also provide an opportunity for the facilitators to ask for any points of clarification in the
training material. Facilitators should observe at least one iteration of the Creating Section 508
Compliant PowerPoint, Word and PDF Documents training prior to leading the course.

The facilitators will be provided with all materials to implement the training including: a
computer, a facilitator guide, a PowerPoint slide presentation, practice files in electronic form,
evaluation files in electronic form, a USB flash drive and reaction surveys. Facilitators should be
prepared to dedicate time prior to the training in order to become fluent in the material.
Facilitators must also agree to provide thorough feedback to participants at the conclusion of
each module and be willing to provide remediation immediately following the course for any
students that have difficulty with any given lesson.

10



Facilitator Guide

Implementation Time

7 hours

Participants
Maximum 20 individuals per iteration

Materials

PowerPoint training presentation (electronic version)
o Slides are referenced in this lesson plan for the purposes of advancing slides at
the correct point in implementation.
Sample PowerPoint, Word and PDF documents for individual activities (electronic
versions)
PowerPoint, Word and PDF documents for final evaluation
Reaction survey (20)
Sign-in sheet
Printed agenda (20)
Notepads and pens (20)

Equipment

Laptop computer with Microsoft Office Suite and Adobe Acrobat
o All participants will also be required to bring their || | JJEE '2rtops with
these programs installed
Computer projector and screen
Flash drive
Extension cords

Room Set-Up

Classro

om style setup for 20 participants. Each table will accommodate 2 chairs facing the front

of the room, with an unobstructed view of the facilitator and projection screen. Each table

should
for the

have access to either a power outlet or an extension cord. Table set-up must also allow
facilitators to walk around the room with ease.

Training room must have Wi-Fi internet access.

In the f

ront of the room will be the facilitators computer set-up alongside the projection screen.

At the entrance of the room will be a table with sign-in sheet, printed agenda, notepads and
pens for participants to complete and pick-up upon arrival.

11



Pre-Course Checklist

One Week
Confirm training room; confirm equipment list; confirm all materials are ready; print agenda;
review presentation.

48 Hours

Dependent upon open seats, contact any individuals that are on the waitlist to fill open seats;
gather any outstanding materials; transfer sample files and final evaluation files to flash drive as
back-up.

Day of Course

Confirm room set-up is complete; arrange appropriate materials on table at entrance of room;
connect your computer to the projector; test that the projector is displaying presentation
properly; open training presentation and cue it to the first slide.

Just Before the Course Starts
Welcome participants as they arrive at the training. Ask them to sign-in, take materials from the
table at the room entrance, turn on their computers and connect to the internet.

12



Lesson Plan
Instructions for the facilitator are provided in bolded and italicized fonts and should not be
read aloud to participants.

Module 1: An Introduction to Section 508 Compliance (45 minutes)
*not developed during EDUC602*

Module 2: How to Make PowerPoints Accessible (1.5 hours)
*not developed during EDUC602*

Module 3: How to Make Word Documents Accessible (1.5 hours)
*not developed during EDUC 602*

Module 4: How to Make PDF Documents Accessible (1.5 hours)

Gaining Attention: 3 minutes

Show slide 1

CREATING SECTION 508 COMPLIANT
POWERPOINT, WORD AND PDF DOCUMENTS
Module 4: How to Make PDFf

Documents Accessible

In your own words:

Now that we have discussed making PowerPoint presentations and Word documents
accessible, we are now ready to go over our last document type covered in this training — PDF
documents.

Ask participants “Why should we make PDF’s Accessible?”
Responses from participants may include:
e legal requirement of federal grant funding
e allows screen readers to accurately read the document so that:
o individuals with impairments to read the document
o individuals with disabilities to read the document

13




If any of the above answers are not mentioned, include them in your explanation.

In your own words:

Most of the work that we do (reports, briefs, etc.) is published on || S As such, it is
a requirement of our federal grant funding that these documents meet Section 508 compliance
as we discussed in Module 1. Under Section 508 compliance, we want to make sure that our
documents are accessible to those with disabilities. Of course we want to avoid legal action, but
as a researcher, you have also put in considerable time into your final product and want it to be
readable by your intended end users.

Note: As mentioned in Module 1, although Section 508 and accessibility means different things,
we use them interchangeably during this training.

Advance to slide 2

Why Make PDF’s Accessible:

* https://www.youtube.com/watch?v=GaNwnsT
4B5s

[\ Mt o 38 At o -

Handout for Class

wtant piece of

Consider this example
Select link and play YouTube video.

In your own words:

Screen readers rely heavily on how we make the PDF accessible. As you can see from this
example, how we set the reading order can change how the document may be read using
assistive technology. Additionally, similar lessons that we learned during Modules 2 and 3 of
this training regarding color contrast and alternative text on images is equally important.

Direction: 3 minutes

Return to PowerPoint presentation. Advance to Slide 3.

14




Objectives

* By the end of this module, you should be able to:

— convert a Word document file to PDF format;

locate and employ a “full check” using the ‘Accessibility’ tool;
locate and employ the “Explain” function within the
‘Accessibility Checker’;

— input the document title and author;

— identify color contrast issues;

— designate the primary language of the document;

— remove unidentified objects and rearrange the reading order of

the document;

— compose missing alternative text on images and figures; and,
— assign header designations to a table.

In your own words, review the objectives that will be covered in this module:

1.

Given instructor demonstration, in-class discussion, a personal computer with Adobe
Acrobat installed, and a Word document practice file, the Creating Section 508
Compliant PowerPoint, Word and PDF Documents participant should be able to convert
a Word document file to PDF format (best for electronic distribution) without error.
Given instructor demonstration, in-class discussion, a personal computer with Adobe
Acrobat installed, and a PDF practice file, the Creating Section 508 Compliant
PowerPoint, Word and PDF Documents participant should be able to locate and employ
a “full check” using the ‘Accessibility’ tool without error.

Given instructor demonstration, in-class discussion, a personal computer with Adobe
Acrobat installed, and a PDF practice file, the Creating Section 508 Compliant
PowerPoint, Word and PDF Documents participant should be able to locate and employ
the “Explain” function within the ‘Accessibility Checker’ without error.

Given instructor demonstration, in-class discussion, a personal computer with Adobe
Acrobat installed, and a PDF practice file, the Creating Section 508 Compliant
PowerPoint, Word and PDF Documents participant should be able to input the
document title and author without error.

Given instructor demonstration, in-class discussion, a personal computer with Adobe
Acrobat installed, internet access, and a PDF practice file, the Creating Section 508
Compliant PowerPoint, Word and PDF Documents participant should be able to identify
color contrast issues without error.

Given instructor demonstration, in-class discussion, a personal computer with Adobe
Acrobat installed, and a PDF practice file, the Creating Section 508 Compliant
PowerPoint, Word and PDF Documents participant should be able to designate the
primary language of the document without error.

Given instructor demonstration, in-class discussion, a personal computer with Adobe
Acrobat installed, and a PDF practice file, the Creating Section 508 Compliant
PowerPoint, Word and PDF Documents participant should be able to remove
unidentified objects in the reading order of the document until completed without
error.
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8.

Given instructor demonstration, in-class discussion, a personal computer with Adobe
Acrobat installed, and a PDF practice file, the Creating Section 508 Compliant
PowerPoint, Word and PDF Documents participant should be able to rearrange the
reading order of the document until completed without error.

Given instructor demonstration, in-class discussion, a personal computer with Adobe
Acrobat installed, and a PDF practice file, the Creating Section 508 Compliant
PowerPoint, Word and PDF Documents participant should be able to compose missing
alternative text on images and figures until completed without error.

10. Given instructor demonstration, in-class discussion, a personal computer with Adobe

Acrobat installed, and a PDF practice file, the Creating Section 508 Compliant
PowerPoint, Word and PDF Documents participant should be able to assign header
designations to a table until completed without error.

Recall: 5 minutes

Ask for a show of hands:
How many of you have made a PDF document accessible before?

If any participants raise their hands, ask them “How did you go about this? What did you do to
the document to make it accessible?” Reinforce any elements we will be discussing today. Be

prepared for elements to be mentioned that do not apply. In that scenario, thank the individual
for sharing and politely state that we will not be addressing those elements. If possible, address
whether they are actually considered an “accessibility” issue.

Advance to slide 4.

Document Elements

Document properties
Images and graphics

Tables
Color contrast

Reading order

Ask the participants:
How might each of these elements be important for someone with an impairment or disability?

Responses should include:

Document properties — Necessary for someone using a screen reader to hear the title
and author of a document, and for the document to be read in the correct language.
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e Images and graphics — Important for someone with visual impairments to be able to
hear alternative text describing the image. Also important for graphics and charts to
meet color contrast requirements.

o Note that not all individuals with visual impairments require the use of a screen
reader. They may have color blindness or low-vision.

e Tables — Important for there to be appropriate labels so that they can be read be a
screen reader.

e Color contrast — Appropriate color contrast is necessary for those with color blindness or
low-vision.

e Reading order — Necessary for those using a screen reader so that the document is read
in the correct order. Also necessary for those that may be using keyboard functions to
‘tab’ or navigate through the document.

Advance to slide 5

Document Elements

* Document properties — visual impairments

* Images and graphics — visual impairments

* Tables — visual impairments

« Color contrast — visual impairments

* Reading order — visual & physical impairments

Be sure to point out any answers that are not mentioned by participants.

Content: 5 minutes

Switch computer projector to show Microsoft Word.

Open PDF_Example.docx document.

This content section will be demonstrated via computer and projector. Screenshots of actions
you will demonstrate are provided in this document as guidance. *Note: this training was
prepared using a Mac computer. Your screen may look slightly different*

In your own words:

In the previous module of this course we learned how to make Word document files accessible.
In an ideal situation, you will be able to prepare a PDF document to be accessible by starting
with the Word document version that you have already made accessible. It will make the
process much quicker.
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The first thing that we will want to do is save the file as a PDF. | am demonstrating on a

(Mac or Windows), so what you see may look slightly different than what |
demonstrate depending on your operating system. However, the basics are the same.
First, on a Mac go to the File>Save As. Choose the PDF file format and select “Best for electronic
distribution and accessibility.” On a Windows computer you will go to File>Save as Adobe PDF.
DO NOT go to File>Save As>PDF as the file will not convert in the same way.

Demonstrate this action.

File Format: PDF T}

o Best for electronic distribution and accessibility
(uses Microsoft online service)

Best for printing

T Export

Open PDF_examplel.pdf document in Adobe Acrobat.
In your own words:
Now that we have the PDF file, we are ready to begin. Keep in mind, you will skip the previous

step if you do not have the Word document file to begin with.

To initiate an accessibility check in Adobe Acrobat, you will need to go to the Tools menu and
open the tool “Accessibility”.

Demonstrate this action.

ene Acrobat Pro DC
T RO .
~
A _ 9 Create POF
Open = Open  * Open -~ Add |~ Edit PDF
[® Export POF
Protect & Standardize Comment
e o . Organize Pages
O e 2 )
\_/ Y s i Enhance Scans
Protect Redact PDF Standards Optimize PDF Print Production () Protact
»
Oper - Add  ~ Add  ~ Add |~ Add -~ % Fill & Sign
. E] Prepare Form
D —
x L Send for Signat
it
Accessibility »~ Send & Track
Oper
Compare Files
D) Accessibiity
Customize
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In your own words:

The menu that then appears on the right side of the screen is where we will initiate the check.
Select “Full Check.”
X

[:% Autotag Document

EE Reading Options
pl

© FullGhock _

@® Accessivility Report
G, \dentify Form Fields
B Set Alternate Text
‘\ Setup Assistant

E}' Reading Order

A dialog box may appear next. If so, choose the options that you wish to check, as seen here

(show dialog box) and choose “Start Checking.”
@ Accessibility Checker Options

Report Options
Create accessibility report  Folder: Macintosh HD:Users:brandi:Documents: Choose...
Attach report to document

Page Range

° All pages in document Pages from to

Checking Options (30 of 32 in all categories)
Category: Document B

Accessibility permission flag is set
Document is not image-only PDF
Document is tagged PDF
Document structure provides a logical reading order
Text language is specified
Document title is showing in title bar
Bookmarks are present in large documents

Document has appropriate color contrast

Select All Clear All

Show this dialog when the Checker starts

Help Cancel Start Checking _

Our report is shown on the left-hand side of the window. As you can see in this document, we
have a number of issues. If we expand each of these we can see exactly what the issues are.
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Accessibility Checker

Accessibility ~
(8
N
@
[®
@

E] B
> Document (6 issues)
5 Page Content (2 issues)
> Forms
a > Alternate Text (5 issues)
o > Tables (4 issues)

> Lists (2 issues)

% > Headings (1 issue)

Expand each of the issue areas and briefly mention the flagged issues.

There are lot of technical issues that may get flagged. Fortunately, there is a helpful feature we
can utilize to provide us with more information. Right click on any item and select explain to be
brought to relevant information on Adobe’s help page. This page will provide an in-depth
description as well as possible resolutions.

Demonstrate this action. After showing Adobe’s webpage, close out of the web browser and
return to Adobe Acrobat.

v Document (6 issues)
o Accessibility permission flag - Passec

o Image-only PDF - Passed

@ Tagged| iy

i‘ Logical Skip Rule mai
) Primary

B Check Again

@ Tite-Fi  ghow Report

© Bookmd Options

Application Feedback 1: 4 minutes

In your own words:

Now that we have briefly reviewed some of the document elements that the Accessibility
checker tests, let’s do a quick activity. Before we proceed are there any questions about the
document elements?
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Respond to any questions as appropriate before proceeding.
Open Applicationlactivity.pdf.

In your own words:
Taking a look at this one page PDF document, let’s quickly go over what the Accessibility
checker may flag. What do you think are likely to be issues?

Possible answers include:
o Title
Author
Primary language
Alternative text on the logo in the header
Labels on the table in the middle of the page
Color contrast on the graphic on the bottom of the page

Provide appropriate feedback on the participants responses and conclude this activity by adding
any of the above points that are not mentioned.

Content 2: 15 minutes

Open PDF_example2.pdf. Run a ‘Full Check.’

In your own words:

Now that we know how to run the check, we need to be able to correct any issues. First, let’s
see what issues are under “Document.”

Expand “Document” category.

The first issue is “Primary language.” Right click on this and select “Fix.” Then choose the
appropriate reading language and press OK. This issue is now resolved.

Demonstrate this action.

@ Title - Failed
i) Bookmarks 4 aLip Rule
W Color contra Explain ik

Page Content | Check Again
Show Report
> ) Taggedcont  QOptions
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P—

Set Reading Language »

Language: English a
Cancel

Next, we’ll do the same for the Title. Right click on “Title” and select “Fix.” When prompted,
enter in the title of the document. This is also where you can enter in the appropriate author of
the document.

Demonstrate this action.
) Title - Failed
i, Book -
A PO Skip Rule

@ color¢ Explain 1 ch

PageCai Check Again
Show Report
» @ Tagget  Options

There are two other issues that will appear under the document category as they require
manual checks. The first item we’re going to focus on is the color contrast. This requires a visual
check that there is enough contrast between the background and any text, and that no visuals
are only expressed using color. For instance, a line graph that only differentiates between lines
with color would not pass. Instead, the lines will need to be different patterns. If you are unsure
of color contrast, you can visit https://webaim.org/resources/contrastchecker/. At this site you
can enter in the hex code of any two colors to determine if they pass color contrast.

Open web browser and go to https://webaim.org/resources/contrastchecker/. Return to
PDF_example2.pdf.

Once the visual check is complete, right click and select “Pass.”

Demonstrate this action.

() Color w gheck_
> Page Cont¢ Fail

Skip Rule
Explain

» Forms

N Atenate T Check Again
Show Report

Tables (4 i
i Sbies (¢ e Options
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The second issue that will appear requires the manual check of the logical reading order of the
document. For individuals using assistive technology, this tells the screen reader the order in
which to read the document. You’ll first need to open the “Order” menu. On the left-hand side
of the screen, select the icon that has four boxes with a Z overlaid. Expand page 1. Right click
and delete any boxes that contain no content. Then drag the items listed under this page to
rearrange them into the logical order. Repeat this for each page. After complete, return to the
accessibility checker, right click on “Logical Reading Order”, and select ‘Pass.’

Demonstrate this action.

@ Acce:

N &
@ -
@

D %
©

’ 2] Accessibility Training Design Plan_20180413.pdf

v [ Pag Show reading order panel

=1 Show page content groups >

~ _ ¥ Display like elements in a single box

% | v Show table cells

- ¥ Show tables and figures aT

- Cut
Delete Selected Item Structure

## | Clear page structure

% | Tag as text/paragraph
> [ Pag Tag as packground/artlfact
Taq as figure

0 Logical Reading Order - Neade manual chank -
@ Primary language - Failed Fail |
Skip Rule

€ Title - Failed A
Explain

73 Bookmarks - Failed

The final two items that we are going to cover in this training are “Alternative Text” and
“Headers.” To fix alternative text, first expand the “Alternative Text” category. Then right click
on any issues and select “Fix.” When prompted, enter in the appropriate alternative text or “alt
text” for the images. Once complete select “Save and Close.” Keep in mind that this should be a
short description of the image that gets across the point to someone that couldn’t otherwise
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see the image or figure. If the image is purely decorative, the alternative text should be left
blank or include a set of empty quotation marks.

Demonstrate this action.

v Alternate Text (5 issues)
C Fguresateme
S o u:inine Clrirm Diila
" et Alternate Text
Image 1 of 31 b
Alternate text: Decorative figure

‘Save & Close Cancel

Finally, we need to address “Headers.” Expand the Tables category. Expand “Headers” and right
click on the issue areas. On the righthand side of the screen select “Reading Order” to bring up
the table editor dialog box. Then select the table with your mouse. Right click on the number in
the upper left-hand corner of the table. Select “Table Editor.” Then right click on the header
row and select “Tale Properties.” Complete the dialog box. To do so you will need to select
header, identify the rows and columns it covers, and then add an ID (the name of the header).
Repeat this for each header.

Demonstrate this action.
X

[} Autotag Document

[33 Reading Options

@ Full Check

@ Accessibility Report
[;"* Identify Form Fields
B Set Alternate Text

’-.\ Setup Assistant

B} Reading Order _
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(-] (= N

¥ Show reading order panel e

Show page content groups > b
¥ Display like elements in a single box
¥ Show table cells
v Show tables and figures

dil

Run Form Field Recognition Cl

Table Editor
Edit Table Summary

Delete Selected Item Structure

: L Autota

CQ Autota

L
Table Cell Properties...
Table Editor Options...

Auto Generate Header Cell IDs
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@® Table Cell Properties

Type i

[ £ Header Cell Scope:  None | T

i Data Cell

[ Attributes

| Row Span: 1

I Column Span: 1 |

|
ID: |
Associated Header Cell IDs: 9P

Cancel [ ok I

Once we finish this and return to the accessibility checker, we will see that we have completed
the check and corrected all errors, making the document accessible. Make sure you finish by
saving your work.

Application Feedback 2: 5 minutes

Switch projector to PowerPoint presentation.
Display next slide.

Application Exercise 1

* Working with a partner, initiate an
accessibility check.
— Open file PDFApplicationExercisel.docx
— Convert to PDF
— Run a "full check” in Adobe Acrobat

In your own words:

Now that we know of the essential steps to initiating an accessibility check of a PDF and the
main elements that may be flagged as issues, let’s apply what you have learned. Working with
the person beside you, begin initiating a check. You should each work to initiate a check on your
own computers, however work together through the process.
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You will first need to open the sample file that | provided to you at the beginning of class. The
file name is “PDFApplicationExercisel.docx.”

After opening the file you will need to convert it to a PDF, and then run a full check. Please ask
any questions as they come up during this activity.

Both instructors should walk around the room while this activity is being completed. Make note

of any issues that participants are having. Encourage participants to work together to help each
other trouble shoot any questions. However, be sure to answer any questions.

After students have completed this activity, briefly discuss any issues that were encountered and
how they were resolved.

Application Feedback 3: 15 minutes

Advance PowerPoint presentation to next slide.

Application Exercise 2

» Working with a partner, resolve all issues
found in the accessibility check.
* Issues found
— Document title
— Reading order
— Color contrast
— Alternative text (x2)

In your own words:

Continue working with your partner to resolve the issues that you found in the previous
exercise. If your document was converted correctly, you should have four issues in total that
need to be resolved. This includes adding the document title, manual checks of the reading
order and color contrast, and fixing missing alternative text on two images.

| will be walking around the room while you complete this exercise. Please ask any questions or
let me know if you need assistance. You will have 10 minutes to complete this exercise. We'll

then reconvene to report out on any problems that were encountered, if any, when completing
this exercise. Please begin.

The co-instructor should keep track of time. Provide a 2 minute warning once 8 minutes have
passed and remind participants that we will be reporting out in 2 minutes.
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Instructors should walk around the room during this exercise. Answer any questions and provide
appropriate feedback to the participants as they make progress. The co-instructor should make
note of any issues, which will be addressed in the report-out.

Note: Participants are likely to have the most difficulty correcting the reading order and
determining how to check color contrast.

After 10 minutes, in your own words address how the last 10 minutes went. Then ask
participants:

How did it go? Would any groups like to report-out on any issues they had?

If no participants volunteer to report out, utilize the list that the co-instructor created. Address
the problem and indicate whether multiple groups had the same trouble.

Evaluation: 31 minutes

Advance PowerPoint presentation to next slide.

Evaluation

* Working alone, prepare a full accessibility
check on the file PDF_Evaluation.docx

In your own words:

It is now time to test what you have learned. Over the next 25 minutes, you will work
individually to make the file PDF_Evaluation.docx into an accessible PDF document. As we will
be using this time to evaluate your learning, | will ask that you please refrain from asking other
participants for assistance. Instead, please continue to ask either of us (the instructors) any
questions. We are here to help. We will also be walking around the room and providing you
with feedback throughout the next 25 minutes.

Ask if anyone has questions before they begin. Answer questions as appropriate.
The co-instructor should keep track of time. After 25 minutes have passed, provide a 5 minute

warning. Both instructors should circulate around the room to provide assistance and feedback
during this evaluation time.
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Be sure to address and provide feedback to each participant throughout the evaluation period.
Since making the PDF accessible requires multiple steps, the evaluation feedback will be ongoing
throughout the evaluation section. It will be helpful to focus on providing feedback to students
at multiple intervals throughout this evaluation period. See below outline for suggested
feedback intervals. If a participant is unable to complete a step, they should be provided
appropriate feedback and assistance which allows them to continue the evaluation. Feedback
should focus on appropriate completion, determined by successful removal of flagged issues.

Evaluation feedback should address (suggested feedback interval time):

e Converting the Word document file to a PDF document (within first 3 minutes);
Initiating the accessibility check (within first 3 minutes);
Adjusting document properties (5-7 minutes into evaluation period);
Adjusting logical reading order (8-13 minutes into evaluation period);
Inserting alternative text (15-18 minutes into evaluation period); and,
Assigning table headers (18-23 minutes into evaluation period).

After completion, lead a discussion to debrief the participants’ mastery. During this time, the
notes taken by the co-instructor throughout the evaluation period should be reviewed. Feedback
on issues encountered should be provided, in addition to how those issues were resolved.

Ask if any participants have questions about the evaluation and their mastery of creating an
accessible PDF document.

Answer questions and provide feedback as appropriate before moving on. Do not move onto the
closure until all questions are answered. If students require additional assistance due to having
difficulty completing the evaluation, direct them to speak with you at the conclusion of the
course.

Closure: 4 minutes

Advance PowerPoint presentation to next slide.

Closure

* Making a PDF accessible
— Converting Word file to PDF
— Initiating an accessibility check
— Utilizing ‘Explain’ function
— Editing document title and author
— Checking color contrast
— Editing primary language
— Adjusting logical reading order
— Inserting alternative text
— Assigning table headers

* Survey
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In your own words:
Before we wrap up for the day, let’s take a few minutes to review what we have covered in this
latest module.

In Module 4 of this training we discussed how to make PDF documents accessible. This
included:
e Converting Word document files to PDF
o There are specific steps that must be taken when saving as a PDF, dependent
upon the operating system you are working on. Remember, starting from an
accessible Word document is ideal and will expedite the process of making the
PDF accessible.
e Initiating an accessibility check
o Luckily, as with many other programs, Adobe has a built in tool that allows us to
check the compliance of a document. By initiating the accessibility check, we are
able to make sure that a document is accessible to those with disabilities and
impairments.
e Utilizing ‘Explain’ function
o While some of the issues that are encountered when making a document
compliant are straight forward, there are some problems that are much more
technical. When we encounter these issues, the ‘Explain’ function in the
accessibility checker can give us a more complete explanation of the issues and
possible ways to resolve the problem.
e Editing document title and author
o The document title and author are required for a screen reader to be able to
read a document, and simple issues to resolve. By right clicking on the flagged
error, we can correct both of these issues in the same dialog box.
e Checking color contrast
o Color contrast is one of the more difficult elements to check. You must know the
color hex codes that are being used and check them using an online contrast
checker. Color contrast should also be checked by ensuring that color is not
being used to convey meaning.
e Editing primary language
o Thisis by right clicking on this error, we can quickly correct the language of the
document so that assistive technologies are able to read the document correctly.
e Adjusting logical reading order
o The logical reading order must be manually checked on every document. You
must remove elements that do not contain text and rearrange each page into
the correct reading order. Again, this allows a screen reader to read the
document appropriately.
e Inserting alternative text
o Images much have short descriptions attached to them, otherwise known as
alternative text. By selecting ‘Fix’ on this error we can edit the alternative text
for any graphics or images. Remember that these descriptions should be brief
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and convey the point that you are trying to get across with the image. Decorative
images should be left blank.
e Assigning table headers
o The last element we discussed are table headers. Every table must have headers
appropriately assigned so that a screen reader is able to read through these
charts and associate data with the correct cells.

Ask if anyone has questions about these key points or anything else discussed during this
training.

You should now have an understanding of what accessibility and Section 508 entails. You also
have learned how to make Word documents, PowerPoints, and PDF documents accessible as
you have shown today. I'd like to thank you all for taking the time to attend today’s training.
Please remember that the training team is here as a resource for you if you have any questions.

Before you go, I'd like to ask you to please complete this anonymous survey to let us know your
thoughts on this training and any areas where you think we can improve. We appreciate your
feedback. You can leave them on the table at the front of the room where you may also pick up
your certificate.

Additionally, the training team will be in contact in about 90 days with another follow-up to see
how you are applying what you have learned today.

Pass out level one evaluation document and ask participants to complete these surveys.
When completed, they may leave them on the table at the entrance of the room as they
depart.

Note: These evaluations are anonymous.
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